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1. SA�ETAK 

 U svom poslu konstruktori � esto koriste standardne dijelove i rješenja. Na taj 

na� in smanjuju vrijeme potrebno za izradu nekog novog rješenja ili konstrukcije, 

smanjuju broj razli� itih dijelova i potrebnih alata, cijenu koštanja proizvoda. Iz tog je 

razloga izrada biblioteke standardnih dijelova i rješenja kao biblioteke zna� ajki za 

odre� eni CAD programski paket od iznimne va�nosti. Proces konstr uiranja se time 

skra� uje, konstruktora osloba� a rutinskih poslova te mu se osigurava više vremena 

za zahtjevnije zada� e. 

 Predmet ovog rada � ine sljede� e skupine standardnih dijelova i rješenja: 

- središnji uvrti,  

- utori za vanjske i unutarnje usko� nike,  

- utori za klinove i pera u dvije izvedbe - obodno glodano i prstasto glodano,  

- pera visoka i niska, 

- utori za O-brtve - aksijalno brtvljenje na vratilu ili osovini, 

   - radijalno brtvljenje na ku� ištu ili poklopcu, 

- utori za Siemering brtve. 

 Potrebno je bilo odrediti mogu� nost i na� in parametrizacije za izradu CAD 

modela te izraditi korisni� ke zna� ajke za svaku skupinu standardnih dijelova. 

Tako� er je trebalo dokumentirati na� in izrade i uporabe gotovih zna� ajki. Zadana 

CAD programska aplikacija je Pro/ENGINEER (u daljnjem tekstu Pro/E). 

 Rad je podijeljen  pet poglavlja. U poglavlju Uvodne napomene opširnije je 

opisan cijeli rad i problemi s kojima sam se susretao te su dane neke napomene. 

Nakon Uvodnih napomena dane su, zbog boljeg razumijevanja, definicije i opisi 

Osnovnih pojmova koje susre� emo u radu. Samu bit rada � ini poglavlje Biblioteka 

standardnih dijelova i oblika u kojem se nalaze svi standardni dijelovi i oblici, 

prikazani slikom iz norme, kratkim opisom normiranih dimenzija te opisom izrade u 

Pro/E-u. Ujedno su dane i detaljne upute za uporabu prakti� nog dijela ovog rada. Na 

kraju se nalazi poglavlje Zaklju� ak u kojem se kriti� ki gleda na rad te se razmatraju 

daljnje mogu� nosti razvoja i nadogradnje. 
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2. UVODNE NAPOMENE 

 Prakti� ni dio rada u cijelosti je izra� en u programskom paketu Pro/E Wildfire 

3.0. Prilikom izrade rada susreo sam se s brojnim poteško� ama kao što su 

nedostupnost potrebnih standarda ali i nepoznavanje samog procesa izrade 

biblioteke standardnih dijelova, to� nije izrade zna� ajki definiranih od strane korisnika 

(UDF). Budu� i da UDF i UDF Family Table ne ulaze u opseg gradiva koji se u� i na 

kolegiju "Konstruiranje pomo� u ra� unala", gdje se u� e osnove rada u Pro/E-u, za 

pripremu rada trebao sam nau� iti kako se to uop� e koristi. Za tu sam svrhu uvelike 

koristio Help Center unutar programa. Osim svega navedenog, kao problem se 

pokazao i sam naziv standardnih dijelova, to� nije, nije bilo mogu� e upisati puno ime 

jer Pro/E ne omogu� uje tako duge nazive kao što su primjerice  

utori_za_o-brtve_za_radijalno_brtvljenje_kada_tlak_djeluje_iznutra.gph, pa su neki 

nazivi zbunjuju� i, odnosno nerazumljivi. Iz tog razloga je prilo�ena tab lica na kraju 

ovog odlomka u kojoj je napisano što koji naziv ozna� ava. 

 Prilikom izrade rada, pozornost je posve� ena i tome da reference odgovaraju 

konfiguracijskoj datoteci koja se koristi na Fakultetu strojarstva i brodogradnje, 

primjerice u slu� aju kada treba odabrati X-Y ravninu. 

 Tijekom pisanja, naveo sam i sve probleme i dvojbe sa kojima sam se 

susretao pa sam zapisao i zašto sam donio neku konkretnu odluku. Nastojao sam se 

i � vrsto dr�ati teme. 

 Cilj rada nije bilo upisivanje kompletnog standarda u tablicu, ve�  analiza, 

razrada i rješenje svake od navedenih stavki do razine prakti� ne uporabe. Dopune i 

izmjene tablice familije (Family Table) za svaku od stavki mo�e se izvoditi naknadno 

neograni� en broj puta. 

 Rad je previ� en za korisnike koji se znaju slu�iti Pro/E-om, no s obziro m na 

detaljne upute za korištenje, vjerojatno bi se i potpuni po� etnici mogli sna� i. Prilikom 

izrade rada, a i prilikom uporabe modela opisanih u radu definirane su neke 

pretpostavke. Primjerice, neophodno je kod modeliranja os vratila postaviti na 

sjecište dvije ravnine koje su automatski odabrane kao reference. To je logi� no za 

sve koji rade u Pro/E-u, a i intuitivno je za po� etnike, tako da gotovo svi korisnici to i 

� ine. Za pretpostavku je uzeto i da korisnik skošenja i zaobljenja postavlja na kraju 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 8 

procesa modeliranja. Unato�  svemu tome, provjerom je utvr� eno da UDF funkcionira 

i ako se korisnik na pridr�ava svih ovih nepisanih pravila. 

 Svaki odlomak sa standardnim dijelovima i oblicima opisan je, s obzirom na 

strukturu, gotovo na identi� an na� in pa se neki koraci ponavljaju doslovno. To je 

u� injeno zato, kada netko ovaj rad koristi prakti� no i �eli pogledati upute za umetanje 

odre� enog dijela, dovoljno je da otvori rad na stranici na kojoj se taj dio nalazi. 

 Na� in ozna� avanja i pisanja koji se koristio u radu je sljede� i. U kurzivu su 

pisane sve engleske rije� i, s iznimkom naslova u prvom poglavlju. Va�ni pojmovi ili  

dijelovi teksta su podebljani. Sve korisni� ke akcije pisane su u podebljanom kurzivu. 

Prilikom prvog spominjanja uz engleske rije� i dan je prijevod na hrvatski jezik. U 

daljnjem tekstu pisane su skra� enice engleskih rije� i gdje je to mogu� e. Razlog zašto 

se u radu koriste engleske rije� i je taj da se u tom obliku nalaze u samome programu, 

a i ve� ina studenata u svakodnevnom govoru koristi ih bez prijevoda. U sljede� oj 

tablici dodatno se prikazuje konvencija o ozna� avanju u radu s primjerima, zbog 

jednostavnijeg pra� enja i snala�enja. 

 

Vrsta teksta Primjer 

Obi� an tekst i 

skra� enice engleskih rije� i 
UDF 

Engleske rije� i i nazivi s 
iznimkom teksta ispod slika i 

tablica 
Family Table 

Korisni� ke akcije File > Save 

Va�ni pojmovi i dijelovi teksta 
s iznimkom naslova Reference  

Tablica 1: Konvencija o ozna� avanju 
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  Tablica 2: Usporedba naziva standardnih dijelova i oblika s nazivima UDF biblioteke unutar Pro/E-a 

 

Puni naziv Naziv UDF biblioteke (.gph) 

niska pera pera_niska 

visoka pera pera_visoka 

središnji uvrt - oblik A sredisnji_uvrt_a 

središnji uvrt - oblik B sredisnji_uvrt_b 

središnji uvrt - oblik D sredisnji_uvrt_d 

središnji uvrt - oblik R sredisnji_uvrt_r 

utori za O-brtve za aksijalno brtvljenje na 
ku� ištu  

ut_o_a_kuciste 

utori za O-brtve za aksijalno brtvljenje na 
vratilu ili osovini 

ut_o_a_vratilo 

utori za O-brtve za radijalno brtvljenje na 
ku� ištu ili poklopcu s tlakom iznutra 

ut_o_r_kuciste_poklopac-tlak_iznutra 

utori za O-brtve za radijalno brtvljenje na 
ku� ištu ili poklopcu s tlakom izvana 

ut_o_r_kuciste_poklopac-tlak_izvana 

utori za klinove i pera visoka izra� eni 
obodnim glodalom 

utori_za_k_pv_obodno 

utori za klinove i pera visoka izra� eni 
prstastim glodalom 

utori_za_k_pv_prstasto 

utori za pera niska izra� eni obodnim 
glodalom 

utori_za_pera_niska_obodno 

utori za pera niska izra� eni prstastim 
glodalom 

utori_za_pera_niska_prstasto 

utori za plosnate klinove izra� eni 
obodnim glodalom utori_za_plosnate_k_obodno 

utori za plosnate klinove izra� eni 
prstastim glodalom utori_za_plosnate_k_prstasto 

utori za Siemering brtve utori_za_siemering_brtve 

utori za unutarnje usko� nike utori_za_unutarnje_uskocnike 

utori za vanjske usko� nike utori_za_vanjske_uskocnike 
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3. OSNOVNI POJMOVI 

3.1. Zna� ajke 

 Zna� ajka (Feature) se mo�e shvatiti kao gradivni dio definicije proizvoda  ili 

geometrijskog poimanja proizvoda. One posjeduju in�e njersko zna� enje, mogu se 

dodijeliti generi� kom obliku i imaju predvidljive osobine. U daljnjem  tekstu dano je 

objašnjenje i definicija osnovnih zna� ajki korištenih u radu. 

 Zna� ajka Extrude slu�i za definiranje trodimenzionalne geometrije tako d a se 

projicira dvodimenzionalni presjek za odre� enu udaljenost u smjeru normale na 

ravninu skiciranja. Extrude Cut je sli� na zna� ajka, samo kod nje ne dodajemo, nego 

oduzimamo materijal. 

 Pomo� u zna� ajke Revolve definiramo geometriju rotacijom presjeka koji smo 

skicirali oko simetrale ili neke osi. Revolve Cut je sli� na zna� ajka, kod koje za razliku 

od obi� ne Revolve zna� ajke ne dodajemo, nego oduzimamo materijal. 

 Round je zna� ajka pomo� u koje mo�emo napraviti zaobljenja na postoje � oj 

geometriji, kao što su zaobljenja na bridovima ili izme� u dviju površina. 

 Zna� ajka Hole omogu� uje nam jednostavno dodavanje provrta na model, tako 

da definiramo polo�aj i karakteristike provrta. Postoji nekoliko vrsta provrta koje 

mo�emo kreirati: 

- jednostavan (Simple) - koristi unaprijed odre� enu geometriju u Pro/E-u, obi� an 

provrt valjkastog oblika; 

- skicirani (Sketched) - koristi oblik koji je korisnik skicirao prema potrebi; 

- standardni (Standard) - koristi oblik temeljen na tablicama s industrijskim 

standardima. 

 

 Datum plane je ravnina koja se dodaje u model i koristi kao referenca jer na 

tom mjestu prethodno ne postoji neka prikladna ravna površina ili druga ravnina.  

 

3.2. Reference 

 Zbog dimenzija i geometrijskih ograni� enja Pro/E zahtjeva od nas da izradimo 

ili izaberemo reference (References).  Reference se mogu izraditi pomo� u dijaloškog 

okvira, no naj� eš� e nas Pro/E automatski pita za odabir referenci, a to je u slu� aju: 

- kada izra� ujemo novu zna� ajku 
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- kada ponovno definiramo zna� ajku kojoj nedostaju reference 

- kada nemamo dovoljno referenci za postavljanje presjeka 

 

 Prilikom izrade novih zna� ajki, Pro/E automatski odabire uobi� ajene reference 

u Sketch-u, a to su obi� no dvije me� usobno okomite ravnine koje su tako� er okomite 

na ravninu crtanja. Ove reference mo�emo po potrebi s ami promijeniti. 

 Radi boljeg razumijevanja referenci koje je potrebno odabrati u radu, one su 

ovdje prikazane slikom i obilje�ene crvenom bojom: 

- � eona površina vratila: 

 
Slika 1: � eona površina vratila 

- ravnina u kojoj se nalazi os vratila: 

 
Slika 2: Ravnina u kojoj se nalazi os vratila 
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- vanjska zaobljena površina vratila (plašt vratila): 

 
Slika 3: Vanjska zaobljena površina vratila 

- os vratila: 

 
Slika 4: Os vratila 

- unutarnja zaobljena površina provrta: 

 
Slika 5: Unutarnja zaobljena površina provrta 
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- površina na kojoj se nalazi provrt: 

 
Slika 6: Površina na kojoj se nalazi provrt 

- os provrta: 

 
Slika 7: Os provrta 

 

3.3. Zna� ajke definirane od strane korisnika  

 Zna� ajka definirana od strane korisnika ili User Defined Feature (u daljnjem 

tekstu UDF) je zna� ajka koja se sastoji od skupa odabranih zna� ajki, svih dimenzija 

povezanih s njima, te svih relacija izme� u odabranih zna� ajki i liste referenci za 

umetanje UDF-a u model. Razlikujemo dvije vrste UDF-a: 

- podre� eni (Subordinate) i  

- samostalni (Standalone).  



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 14 

 Podre� eni UDF dobiva svoje vrijednosti direktno iz po� etnog modela, stoga 

po� etni model mora biti prisutan da bi podre� eni UDF funkcionirao. U slu� aju da 

promijenimo vrijednosti dimenzija na po� etnom modelu, to se odmah automatski 

odra�ava na UDF-u. 

 Samostalni UDF kopira sve informacije s originalnog modela u UDF datoteku. 

Zbog toga zahtjeva malo više prostora na disku nego podre� eni UDF, no s obzirom 

na veli� ine današnjih diskova, to je zanemarivo. Kod samostalnog UDF-a, u slu� aju 

da napravimo neke promjene na referentnom modelu, one se ne odra�avaju na UDF-

u. Prilikom kreiranja samostalnog UDF-a imamo mogu� nost kreirati referentni dio 

kopiranjem iz originalnog modela od kojeg je nastao UDF. To je vrlo korisno jer tada 

postoji mogu� nost prikazivanja referentnog modela dok postavljamo UDF u novi 

model. Tada se prikazuju potrebne dimenzije (ako ih ima) i reference koje korisnik 

mo�e odabrati. U radu sam koristio samostalne UDF-ove. 

Vrste dimenzija koje nalazimo u UDF-u: 

- promjenjive - dimenzije � ije vrijednosti korisnik mo�e birati prilikom umetanja 

UDF-a u model; 

- nepromjenjive - dimenzije � ije vrijednosti se ne mogu birati prilikom umetanja 

 UDF-a u model; 

- dimenzije upravljane tablicom - dimenzije � ije su vrijednosti odre� ene u Family 

Table-u; 

 

3.4. Relacije 

 Relacije (Relations), poznate kao i parametarske relacije, su jednad�be 

definirane od strane korisnika. U njima se nalaze simboli dimenzija i parametara. 

Relacije nam omogu� uju da ostvarimo povezivanje parametara razli� itih dijelova 

konstrukcije definiranjem veza unutar dijela (Part) ili izme� u komponenata u sklopu 

(Assembly). Dakle, relacije mo�emo koristiti za kontroliranje pro cesa modeliranja na 

sljede� e na� ine: 

- za kontroliranje efekata modifikacija na modelu; 

- za definiranje vrijednosti dimenzija u dijelu i sklopu; 

- za postavljanje ograni� enja kod konstruiranja, primjerice, za odre� ivanje 

polo�aja provrta u odnosu na rub dijela; 

- za opisivanje uvjetnih veza izme� u razli� itih dijelova modela ili sklopa. 
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Razlikujemo dva tipa relacija: 

- jednakost - izjedna� avanje parametara na lijevoj strani jednad�be s izrazom na 

desnoj strani. Ovaj tip relacije se koristi za davanje vrijednosti dimenzijama i 

parametrima; 

- usporedba - uspore� uje izraz na lijevoj strani jednad�be s izrazom na desn oj 

strani. Ovaj tip relacije se op� enito koristi kao ograni� enje ili kao uvjet. 

 

3.5. Tablica familije 

 Tablica familije ili Family Table je skupina dijelova (ili sklopova ili zna� ajki) koji 

su u biti isti, ali se razlikuju u jedan ili dva aspekta, kao što je veli� ina ili detaljnost 

zna� ajki. Tablice objedinjuju podatke o odabranim dimenzijama te stanjima pojedinih 

zna� ajki dijelova, sklopova ili oblika na koje se odnose (isklju� eno/uklju� eno). 

Korištenjem Family Table-ova mo�emo: 

- jednostavno i kompaktno izraditi i spremiti brojne objekte; 

- uštediti vrijeme i trud standardiziranjem nastajanja dijelova; 

- izraditi varijacije dijelova od jednog po� etnog dijela bez da ponovno izradimo ili 

generiramo svaki od njih; 

- izraditi male varijacije u dijelu bez da koristimo relacije za mijenjanje modela; 

- izraditi tablicu dijelova koji mogu biti spremljeni u datoteku za ispis i uklju� eni u 

kataloge dijelova. 

Family Table-ovi potpoma�u upotrebu standardiziranih dijelova.  

 

3.6. Korisni � ki definirane zna � ajke u tablici familije  

 Korisni� ki definirane zna� ajke u tablici familije ili User Defind Feature Family 

Table malo se razlikuje od obi� nih Family Table-ova po sljede� im ograni� enjima: 

- instance UDF-a se ne povla� e zasebno, osim ako se UDF postavlja na dio. U  

tom slu� aju, kada izaberemo izvorni UDF, otvara se dijaloški okvir i tada    

odabiremo koju � emo instancu koristiti; 

- UDF Family Table se kreira za vrijeme definiranja ili modificiranja UDF-a,    

koriste� i dijaloški okvir; 

- instanca UDF-a ne mo�e se povu � i u odvojenom prozoru; 

- instancu UDF-a se ne mo�e verificirati; 
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- kada se UDF koji je definran Family Table-om postavlja na model, sve 

zna� ajke u instanci UDF-a koje su potisnute (Supressed) ne� e biti postavljene 

na  model. Ove zna� ajke zapravo su izbrisane nakon što se UDF postavi; 

 

 Za izradu UDF biblioteke, preporu� ljivo je napraviti posebnu mapu. Svi 

korisnici ra� unala moraju imati dopuštenje za pristup toj mapi. Da bi Pro/E automatski 

otvarao mapu s UDF bibliotekom, potrebno ju je navesti u konfiguracijskoj datoteci 

pod opcijom pro_group_dir. Tako� er, mo�e se podesiti i stablo mapa kako bi se 

omogu� ila hijerarhija UDF biblioteke. 
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4. BIBLIOTEKA STANDARDNIH DIJELOVA I OBLIKA 

4.1. Utori za vanjske usko � nike 

Utore za vanjske usko� nike opisuje norma DIN 471. Izgled utora prema normi: 

 
Slika 8: Izgled utora za vanjske usko� nike 

 

Dimenzije koje su odre� ene normom: 

- dimenzija d ozna� ava promjer vratila na koje se stavlja usko� nik;   

- dimenzija n1 min ozna� ava minimalnu udaljenost od � eone površine vratila do 

po� etka utora;  

- dimenzija d1 ozna� ava unutarnji promjer utora i izra� uje se u tolerancijskom 

polju h11;  

- dimenzija m ozna� ava širinu utora i izra� uje se u tolerancijskom polju H13. 

 

 Utor za vanjske usko� nike je izra� en kao kombinacija dvije zna� ajke - Datum 

Plane-a i Extrude-a, budu� i da je to rješenje za koje Pro/E  tra�i najmanje refe renci, u 

ovom slu� aju - tri, a to su � eona površina vratila i dvije ravnine u kojoj se nalazi os 

vratila. Razli� itim na� inima se pokušalo još smanjiti broj referenci, pogotovo ravnina, 

ali i kad se u potpunosti eliminiraju, ipak, zbog definicije zna� ajki unutar Pro/E-a 

nu�no je imati najmanje jednu. Umjesto dviju ravnina za reference se mogla izabrati i 

kombinacija ravnine i vanjske površine vratila ili ravnine i osi vratila. Na kraju su 

izabrane dvije ravnine, jer onda nije potrebno uklju� iti prikaz osi, kao što bi to bilo u 

drugom slu� aju, a broj referenci je ionako jednak. 
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 UDF je izra� en tako da je iz Datum Plane-a, koji se nalazi na n1 min  

udaljenosti od � eone površine vratila, ekstrudiran utor kao Extrude Cut dimenzije m. 

Vanjska kru�nica zna � ajke Extrude Cut povezana je s unutrašnjim promjerom utora 

(dimenzija d1 u normi) relacijama na na� in da je ta vanjska kru�nica dva puta ve � a. 

Na taj na� in se osigurava da UDF uvijek sigurno funkcionira kako treba. Sve 

tolerancije su postavljene na potrebnim kotama. 

 

 
Slika 9: Izgled utora za vanjske usko� nike tijekom modeliranja za UDF 

 U dogovoru s mentorom odlu� eno je da se utor automatski postavlja na 

udaljenost n1 min kako je odre� eno normom. U slu� aju da korisnik utor �eli postaviti 

na ve� u udaljenost treba jednostavno izmijeniti tu dimenziju nakon umetanja. 

 

Proces umetanja UDF-a od strane korisnika:  

 Razumljivo je da korisnik mora imati izmodelirano vratilo, odnosno, samo dio 

vratila na koji se stavlja utor. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapu sa standardnim dijelovima, u ovom 

primjeru nazvanu standardni_dijelovi.  
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Slika 10: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na utori_za_vanjske_uskocnike.gph, isti odaberu, te se zatim klikne na Open. 

Tada se otvara novi prozor u kojem je automatski odabrana druga opcija i tako treba 

ostaviti jer ona omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U 

slu� aju da se isklju� i korisnik � e morati ponovno definirati reference, i to za svaku 

zna� ajku posebno. Ako korisnik �eli, mo�e odabrati pored druge , još i tre� u opciju, 

što je preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog 

dijela. Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji se modelira. 

 
Slika 11: Insert UDF prozor i opcije 
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 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista usko� nika sortiranih po promjeru vratila.  

 
Slika 12: Odabir potrebnog usko� nika prema promjeru vratila 

 Iz te liste odabere se promjer vratila na koji se stavlja usko� nik, te klikne na 

Open. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 13: UDF Placement prozor i opcije 
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 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati � eonu 

površinu vratila, a nakon odabira u dijaloškom okviru odabrati 2. SURFACE, te sa 

strane pro� itati što se tra�i. U drugom koraku to je jedna od rav nina u kojoj se nalazi 

os vratila, te je potrebno kliknuti na nju da bismo je odabrali. Nakon toga, postupak 

se ponovi još jednom, odabere se 3. SURFACE, te se zatim odabere druga ravnina u 

kojoj se nalazi os vratila. Odabir se na kraju potvr� uje klikom na zelenu kva� icu. 

Nakon toga otvara se još jedan prozor, gdje je samo potrebno kliknuti na Okay za 

potvrdu orijentacije. 

 
Slika 14: Potvrda orijentacije 

 Zatim se otvara još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 

 
Slika 15: Potvrda za kraj umetanja UDF-a 
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4.2. Utori za unutarnje usko � nike 

Utore za unutarnje usko� nike opisuje norma DIN 472. Izgled utora po normi: 

 
Slika 16: Izgled utora za unutarnje usko� nike 

Dimenzije koje su odre� ene normom: 

- dimenzija d ozna� ava promjer provrta u koji se stavlja usko� nik;   

- dimenzija n1 min ozna� ava minimalnu udaljenost od vanjske površine ku� išta 

do po� etka utora;  

- dimenzija d1 ozna� ava vanjski promjer utora i izra� uje se u tolerancijskom 

polju H11; 

- dimenzija m ozna� ava širinu utora i izra� uje se u tolerancijskom polju H13. 

 

 Utor za unutarnje usko� nike izra� en je kao kombinacija dvije zna� ajke - 

Datum Plane-a i Extrude-a, budu� i da je to rješenje za koje Pro/E  tra�i najmanje 

referenci, u ovom slu� aju - tri, a to su vanjska površina ku� išta na kojoj se nalazi 

provrt, bilo koja površina ili ravnina koja je okomita na tu vanjsku površinu ku� išta na 

kojoj je izbušen provrt i unutarnja zaobljena površina provrta.  

 UDF je izra� en tako da je iz Datum Plane-a, koji se nalazi na n1 min  

udaljenosti od vanjske površine ku� išta, ekstrudiran utor kao Extrude Cut dimenzije 

m. Unutarnja kru�nica zna � ajke Extrude Cut povezana je s vanjskim promjerom utora 

(dimenzija d1 u normi) relacijama na na� in da je ta unutarnja kru�nica dva puta 

manja. Na taj na� in se osigurava da UDF uvijek sigurno funkcionira kako treba. Sve 

tolerancije su postavljene na potrebnim kotama. 
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Slika 17: Izgled utora za vanjske usko� nike u presjeku tijekom modeliranja za UDF 

 U dogovoru s mentorom odlu� eno je da se utor automatski postavlja na 

udaljenost n1 min. U slu� aju da korisnik �eli postaviti utor na ve � u udaljenost, treba 

jednostavno editirati tu dimenziju nakon umetanja. 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran provrt u ku� ištu u koji se postavlja utor. 

Umetanje zapo� inje klikom na Insert > User Defined Feature... , nakon � ega treba 

odabrati mapu sa standardnim dijelovima, u ovom primjeru nazvanu 

standardni_dijelovi.  

 
Slika 18: Prvi korak kod ubacivanja UDF-a u model 
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 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na utori_za_unutarnje_uskocnike.gph, isti odaberu, te se zatim klikne na 

Open. Tada se otvara novi prozor u kojem je automatski odabrana druga opcija i 

tako treba ostaviti jer ona omogu� uje odabir prije definiranih referenci za grupu 

zna� ajki. U slu� aju da se isklju� i, korisnik � e morati ponovno definirati reference, i to 

za svaku zna� ajku posebno. Ako korisnik �eli, pored druge, mo�e odabr ati još i tre� u 

opciju, što je preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje 

odre� enog dijela. Ta tre� a opcija (View source model ) omogu� uje da se prika�e 

izvorni model s ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 

 
Slika 19: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista usko� nika sortiranih po promjeru provrta.  

 
Slika 20: Odabir potrebnog usko� nika prema promjeru provrta 
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 Iz te liste odabere se promjer provrta u koji se stavlja usko� nik, te klikne na 

Open. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 21: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati vanjsku 

površinu ku� išta na kojoj je izbušen provrt, a nakon odabira u dijaloškom okviru 

odabrati 2. SURFACE, te sa strane pro� itati što se tra�i. U drugom koraku to je bilo 

koja površina ili ravnina koja je okomita na prethodnu površinu, te je potrebno kliknuti 

na nju da bismo je odabrali. Nakon toga, sli� an postupak se ponovi još jednom, 

odabere se 3. SURFACE, te se zatim klikne na unutarnju zaobljenu površinu provrta. 

Odabir se na kraju potvr� uje klikom na zelenu kva� icu. Nakon toga otvara se još 

jedan prozor, gdje je samo potrebno kliknuti na Okay za potvrdu orijentacije. 

 
Slika 22: Potvrda orijentacije 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 23: Potvrda za kraj umetanja UDF-a 
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4.3. Visoka i niska pera 

 Visoka i niska pera su elementi strojeva kojima se ostvaruje rastavljivi spoj 

izme� u vratila i glavine. Opisuje ih norma DIN 6885. Izgled visokog i/ili niskog pera 

po normi: 

 
Slika 24: Izgled visokog i/ili niskog pera 

Dimenzije koje su odre� ene normom: 

- dimenzija b ozna� ava širinu presjeka pera i izra� uje se u tolerancijskom polju 

h11; 

- dimenzija h ozna� ava visinu pera.  

 

 Pera se dosta razlikuju s obzirom na ostale dijelove i oblike u ovom radu zato 

jer nisu dio nekog drugog dijela, ve�  su dio sama za sebe, dok  je primjerice utor za 

vanjske usko� nike dio vratila. Izra� ena su pomo� u dvije zna� ajke - Extrude i Round. 

Glavni razlog zbog � ega su napravljena kao UDF je da korisnik prilikom ubacivanja u 

model mo�e odabrati duljinu, budu � i da je to dimenzija koja nije odre� ena normom. 

Broj referenci koji ovaj UDF tra�i je tri, a to su tr i glavne ravnine. 

 UDF je izra� en tako da je napravljen Sketch dimenzija b x h i ekstrudiran za 

10 mm. Na rubove su dodana zaobljenja koja su povezana relacijama sa širinom b 

na na� in da su dva puta manja.  

 
Slika 25: Izgled pera tijekom modeliranja za UDF 
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Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora biti u novom dijelu, File > New > Part > OK , te bi trebalo 

uklju� iti prikaz ravnina. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapu sa standardnim dijelovima, u ovom 

primjeru nazvanu standardni_dijelovi.  

 
Slika 26: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

odaberu pera_visoka.gph ili pera_niska.gph, ovisno koja trebamo, te se zatim klikne 

na Open. Tada se otvara novi prozor u kojem je automatski odabrana druga opcija i 

tako treba ostaviti jer ona omogu� uje odabir prije definiranih referenci za grupu 

zna� ajki. U slu� aju da se isklju� i, korisnik � e morati ponovno definirati reference, i to 

za svaku zna� ajku posebno. Ako korisnik �eli, pored druge, mo�e odabr ati još i tre� u 

opciju, što je preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje 

odre� enog dijela. Ta tre� a opcija (View source model ) omogu� uje da se prika�e 

izvorni model s ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 
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Slika 27: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista pera sortiranih po promjeru vratila.  

 
Slika 28: Odabir potrebnog pera prema promjeru vratila 

 Iz te liste odabere se promjer vratila na koje � e se pero staviti u sklopu, te se 

klikne na Open. Treba napomenuti da se zbog nemogu� nosti korištenja ikakvih 

simbola osim crta u nazivu instanci, zadnji promjer isklju� uje. Zatim se otvara User 

Defined Feature Placement okvir. 

 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 29 

 
Slika 29: UDF Placement prozor, opcije i izbor duljine pera 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati Y-Z ravninu 

(ili RIGHT, ovisno o konfiguracijskoj datoteci), a nakon odabira u dijaloškom okviru 

odabrati 2. SURFACE, te sa strane pro� itati što se tra�i. U drugom koraku to je X-Z 

ravnina (TOP), te je potrebno kliknuti na nju da bismo je odabrali. Nakon toga, sli� an 

postupak se ponovi još jednom, odabere se 3. SURFACE, te se zatim klikne na X-Y 

ravninu (FRONT). Zatim je u istom tom prozoru (UDF Placement) potrebno kliknuti 

na Variables , te pod opcijom Value unijeti duljinu pera. Odabir se na kraju potvr� uje 

klikom na zelenu kva� icu. Nakon toga otvaraju se još dva ista prozora, gdje je samo 

potrebno kliknuti na Okay za potvrdu orijentacije. 

 
Slika 30: Potvrda orijentacije 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done.  
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Slika 31: Potvrda za kraj umetanja UDF-a 

 Sada smo dobili pero tra�enih dimenzija u modelu, no  umetanje još nije 

potpuno završeno jer je ovaj model potrebno regenerirati da bi se prilagodila 

zaobljenja koja su povezana pomo� u relacija. To � emo u� initi klikom na Edit > 

Regenerate  ili pomo� u pre� aca sa tipkovnice Ctrl+G . Ovime je završen proces 

umetanja ovog UDF-a. Sada je preporu� ljivo spremiti pero gdje �elimo, da bismo ga 

mogli koristiti u za to predvi� enom sklopu, pomo� u File > Save  ili File > Save a 

copy . 

 

4.4. Utori za klinove i pera 

Utore za klinove i pera opisuje norma DIN 6885. Izgled utora po normi: 

 
Slika 32: Izgled utora za klinove i pera 

Dimenzije koje su odre� ene normom: 

- dimenzija b ozna� ava širinu utora i izra� uje se u tolerancijskom polju P9;  

- dimenzija t ozna� ava dubinu utora u vratilu; 

- dimenzija d ozna� ava promjer vratila na kojemu se nalazi utor.  
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 Utori za klinove i pera podijeljeni su u nekoliko datoteka, da bi bilo lakše i 

preglednije za samog korisnika. Prva opcija je bila staviti sve utore za klinove i pera u 

jedan UDF i kada korisnik postavlja UDF na model, otvara mu se velika tablica sa 

svim utorima za sve vrste klinova i pera (visoka pera i klinovi, niska pera, te plosnati 

klinovi). Drugo rješenje, koje je uzeto kao i krajnje rješenje u ovom radu, bilo je ve�  

na po� etku razvrstati i odvojiti na tri puta po dvije skupine - utore za visoka pera i 

klinove, niska pera, te plosnate klinove, još dodatno odvojene s obzirom jesu li 

izra� eni obodnim ili prstastim glodalom. U ovom slu� aju kada korisnik postavlja UDF 

na model otvara mu se samo tablica koju je zatra�io, p rimjerice utori za plosnate 

klinove izra� ene prstastim glodalom. Utori za visoka pera i klinove nalaze se u istom 

UDF-u jer su potpuno istih dimenzija. 

 

4.4.1. Obodno glodano 

Izgled utora izra� enog obodnim glodalom: 

 
Slika 33: Izgled utora izra� enog obodnim glodalom 

 Obodno glodani utor za klinove i pera izra� en je kao kombinacija dvije 

zna� ajke - Extrude-a i Round-a. Za to rješenje Pro/E  tra�i tri reference, a to su bilo 

koja ravnina u kojoj se nalazi os vratila, � eona površina vratila i vanjska zaobljena 

površina vratila (plašt). 
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 UDF je izra� en tako da je u presjeku vratila nacrtan pravokutnik sa 

dimenzijama utora i ekstrudiran s opcijom Cut na obje strane za vrijednost jednaku 

širini utora. Nakon toga dodana su zaobljenja na potrebne bridove kako bi utor 

izgledao kao da je izra� en obodnim glodalom. Sve tolerancije su postavljene na 

potrebnim kotama. 

 
Slika 34: Izgled obodno glodanog utora za klinove i pera u presjeku tijekom modeliranja za UDF 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodelirano vratilo na koje se postavlja utor. Umetanje 

zapo� inje klikom na Insert > User Defined Feature... , nakon � ega se treba odabrati 

mapa sa standardnim dijelovima, u ovom primjeru nazvana standardni_dijelovi.  

 

 
Slika 35: Prvi korak kod ubacivanja UDF-a u model 
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 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore (obodno glodane), isti odaber u, te se zatim klikne na Open. 

Tada se otvara novi prozor u kojem je automatski odabrana druga opcija i tako treba 

ostaviti jer ona omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U 

slu� aju da se isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku 

zna� ajku posebno. Ako korisnik �eli, pored druge, mo�e odabra ti još i tre� u opciju, 

što je preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog 

dijela. Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 

 
Slika 36: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru vratila. 

 
Slika 37: Izbor utora prema promjeru vratila 
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 Iz te liste odabere se promjer vratila na koji se stavlja utor, te se klikne na 

Open. Treba napomenuti da se zbog nemogu� nosti korištenja ikakvih simbola osim 

crta u nazivu instanci, zadnji promjer isklju� uje. Zatim se otvara User Defined Feature 

Placement okvir. 

 
Slika 38: UDF Placement prozor, opcije i izbor varijabilnih dimenzija 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati bilo koju 

ravninu u kojoj se nalazi os vratila, a nakon odabira u dijaloškom okviru odabrati 2. 

SURFACE, te sa strane pro� itati što se tra�i. U drugom koraku to je � eona površina 

vratila, te je potrebno kliknuti na nju da bismo je odabrali. Nakon toga, sli� an 

postupak se ponovi još jednom, odabere se 3. SURFACE, te se zatim klikne na 

vanjsku zaobljenu površinu vratila. Zatim u istom tom prozoru (UDF Placement) 

potrebno je kliknuti na Variables, te pod opcijom Value unesti sve tri tra�ene 

dimenzije. Ove dimenzije nisu odre� ene normom, a one su prikazane u tablici ovim 

redom: duljina utora, udaljenost od kraja vratila do po� etka utora i polumjer glodala. 

Odabir se na kraju potvr� uje klikom na zelenu kva� icu. Nakon toga otvara se još 

jedan prozor, gdje je samo potrebno kliknuti na Okay za potvrdu orijentacije. 
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Slika 39: Potvrda orijentacije 

 Onda se pojavljuje prozor u kojem je potrebno odabrati Next , a nakon toga u 

istom prozoru stisnuti Accept . Ovim postupkom odabiremo sljede� u referencu 

izme� u dvije ponu� ene, budu� i da referenca koju Pro/E automatski ponudi nije 

dobra. Ako se stisne samo Accept , bez prethodnog odabira Next , utor � e se 

napraviti izvan vratila u praznom prostoru i  ne� e biti vidljiv na modelu ili � e Pro/E 

javiti grešku kod umetanja. 

 
Slika 40: Izbor sljede� e reference 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 41: Potvrda za kraj umetanja UDF-a 
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4.4.2. Prstasto glodano 

Izgled utora glodanog prstastim glodalom: 

 
Slika 42: Izgled utora glodanog prstastim glodalom 

 Prstasto glodani utor za klinove i pera izra� en je kao kombinacija dvije 

zna� ajke - Extrude-a i Round-a. Za to rješenje Pro/E  tra�i tri reference, a to su bilo 

koja ravnina u kojoj se nalazi os vratila, � eona površina vratila i vanjska zaobljena 

površina vratila (plašt). 

 UDF je izra� en tako da je u presjeku vratila nacrtan pravokutnik sa 

dimenzijama utora i ekstrudiran pomo� u opcije Cut na obje strane za vrijednost 

jednaku širini utora. Nakon toga dodana su zaobljenja na potrebne bridove kako bi 

utor izgledao kao da je izra� en prstastim glodalom. Sve tolerancije su postavljene na 

potrebnim kotama. 

 
Slika 43: Izgled prstasto glodanog utora za klinove i pera tijekom modeliranja za UDF 
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Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodelirano vratilo na koji se postavlja utor. Umetanje 

zapo� inje klikom na Insert > User Defined Feature... , nakon � ega treba odabrati 

mapa sa standardnim dijelovima, u ovom primjeru nazvan standardni_dijelovi.  

 

 
Slika 44: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore (prstasto glodane), isti odaberu,  te se zatim klikne na Open. 

Tada se otvara novi prozor u kojem je automatski odabrana druga opcija i tako treba 

ostaviti jer ona omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U 

slu� aju da se isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku 

zna� ajku posebno. Ako korisnik �eli, pored druge, mo�e odabra ti još i tre� u opciju, 

što je preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog 

dijela. Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 
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Slika 45: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru vratila.  

 

Slika 46: Izbor utora prema promjeru vratila 

 Iz te liste odabere se promjer vratila u koji se stavlja utor, te klikne na Open. 

Treba napomenuti da se zbog nemogu� nosti korištenja ikakvih simbola osim crta u 

nazivu instanci, zadnji promjer isklju� uje. Zatim se otvara User Defined Feature 

Placement okvir. 
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Slika 47: UDF Placement prozor, opcije i izbor varijabilnih dimenzija 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati bilo koju 

ravninu u kojoj se nalazi os vratila, a nakon odabira u dijaloškom okviru odabrati 2. 

SURFACE, te sa strane pro� itati što se tra�i. U drugom koraku to je � eona površina 

vratila, te je potrebno kliknuti na nju da bismo je odabrali. Nakon toga, sli� an 

postupak se ponovi još jednom, odabere se 3. SURFACE, te se zatim klikne na 

vanjsku zaobljenu površinu vratila. Zatim u istom tom prozoru (UDF Placement) 

potrebno je kliknuti na Variables, te pod opcijom Value unesti sve tra�ene dimenzije, 

u ovom slu� aju dvije. Ove dimenzije nisu odre� ene normom, a one su prikazane u 

tablici ovim redom: duljina utora, te udaljenost od � eone površine vratila do po� etka 

utora. Odabir se na kraju potvr� uje klikom na zelenu kva� icu. Nakon toga otvara se 

još jedan prozor, gdje je samo potrebno kliknuti na Okay za potvrdu orijentacije. 

 
Slika 48: Potvrda orijentacije 
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 Onda se pojavljuje prozor u kojem je potrebno odabrati Next , a nakon toga u 

istom prozoru stisnuti Accept . Ovim postupkom odabiremo sljede� u referencu 

izme� u dvije ponu� ene, budu� i da referenca koju Pro/E automatski ponudi nije 

dobra. Ako se stisne samo Accept , bez prethodnog odabira Next , utor � e se 

napraviti izvan vratila u praznom prostoru i  ne� e biti vidljiv na modelu ili � e Pro/E 

javiti grešku kod umetanja. 

 
Slika 49: Izbor sljede� e reference 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 50: Potvrda za kraj umetanja UDF-a 
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4.5. Središnji uvrti 

Središnje uvrte opisuje norma DIN 332.  Svi središnji uvrti nisu izra� eni unutar jednog 

UDF-a, nego su podijeljeni na � etiri UDF-a ovisno o obliku (A, B, D, R). 

 

4.5.1. Središnji uvrt oblika A 

Izgled središnjeg uvrta oblika A po normi : 

 
Slika 51: Izgled središnjeg uvrta oblika A 

 

Dimenzije koje su odre� ene normom: 

- dimenzija d1;  

- dimenzija d2;  

- dimenzija l1 min;  

- kut od maksimalno 60°; 

 

 Središnji uvrt oblika A napravljen je pomo� u samo jedne zna� ajke - Hole. Za 

to rješenje Pro/E  tra�i samo dvije reference, a to su površina na kojoj se nalazi utor i 

os vratila. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 42 

 
Slika 52: Izgled središnjeg uvrta oblika A u Sketch-u tijekom modeliranja za UDF 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran dio vratila na koji se postavlja uvrt, a potrebno 

je uklju� iti i prikaz osi. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapa sa standardnim dijelovima, u ovom 

primjeru nazvan standardni_dijelovi.  

 
Slika 53: Prvi korak kod ubacivanja UDF-a u model 
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 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako navedena pod opcijom pro_group_dir u konfiguracijskoj 

datoteci. Drugi korak je da se u mapi sa standardnim dijelovima klikom na �eljene 

uvrte, isti odaberu, te se zatim klikne na Open. Tada se otvara novi prozor u kojem je 

automatski odabrana druga opcija i tako treba ostaviti jer ona omogu� uje odabir prije 

definiranih referenci za grupu zna� ajki. U slu� aju da se isklju� i, korisnik � e morati 

ponovno definirati reference, i to za svaku zna� ajku posebno. Ako korisnik �eli, pored 

druge, mo�e odabrati još i tre � u opciju, što je preporu� ljivo za po� etak dok se ne 

stekne "osje� aj" za umetanje odre� enog dijela. Ta tre� a opcija (View source model ) 

omogu� uje da se prika�e izvorni model s ozna � enim referencama koje treba odabrati 

na dijelu koji modeliramo. 

 
Slika 54: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista uvrta sortiranih po promjeru vratila. 

 
Slika 55: Odabir središnjeg uvrta A prema promjeru vratila 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 44 

 Iz liste odabere se promjer vratila, te se klikne na Open. Treba napomenuti da 

se zbog nemogu� nosti korištenja ikakvih simbola osim crta u nazivu instanci, zadnji 

promjer isklju� uje. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 56: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati površinu 

vratila na kojoj se nalazi utor, a nakon odabira u dijaloškom okviru odabrati 2. AXIS, 

te sa strane pro� itati što se tra�i. U drugom koraku to je os vratila.  O dabir se na kraju 

potvr� uje klikom na zelenu kva� icu.  

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 57: Potvrda za kraj umetanja UDF-a 
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4.5.2. Središnji uvrt oblika B 

Izgled središnjeg uvrta oblika B po normi : 

 
Slika 58: Izgled središnjeg uvrta oblika B 

 

Dimenzije koje su odre� ene normom: 

- dimenzija d1;  

- dimenzija d2;  

- dimenzija d3;  

- dimenzija l1 min;  

- unutrašnji kut od maksimalno 60°; 

- vanjski kut od 120°. 

 

 Središnji uvrt oblika B napravljen je pomo� u samo jedne zna� ajke - Hole. Za 

to rješenje Pro/E  tra�i samo dvije reference, a to su površina na kojoj se nalazi utor i 

os vratila. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 
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Slika 59: Izgled središnjeg uvrta oblika A u Sketch-u tijekom modeliranja za UDF 

Proces umetanja UDF-a od strane korisnika pogledati na stranici 42. 

 

4.5.3. Središnji uvrt oblika D 

Izgled središnjeg uvrta oblika D po normi : 

 
Slika 60: Izgled središnjeg uvrta oblika D 
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Dimenzije koje su odre� ene normom: 

- dimenzija d1;  

- dimenzija d2;  

- dimenzija d3;  

- dimenzija l1;  

- dimenzija l2;  

- dimenzija l3;  

- dimenzija c;  

- dimenzija navoja Md; 

- unutarnji kut od maksimalno 60°; 

- vanjski kut od 120. 

 

 Dimenzije l3 i c u normi su dane kao pribli�ne dimenzije, te ih je ne mogu� e 

unijeti u model, odnosno Sketch, jer je tada predimenzioniran. Mjerenjem u Pro/E-u 

(Analysis > Measure > Distance ) nakon ubacivanja bilo kojeg UDF-a iz ove tablice 

utvr� eno je da nakon ubacivanja UDF-a, te pribli�ne dimenzij e iz norme odgovaraju 

dimenzijama na UDF-u. 

 Središnji uvrt oblika D napravljen je pomo� u dvije Hole zna� ajke. Za to 

rješenje Pro/E  tra�i samo dvije reference, a to su povr šina na kojoj se nalazi uvrt i os 

vratila. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan gornji oblik utora. 

 
Slika 61: Izgled gornjeg dijela središnjeg uvrta oblika D u Sketch-u tijekom modeliranja za UDF 
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 Nakon toga, na donju površinu utora postavljena je druga zna� ajka Hole, ovaj 

puta pod opcijom Standard hole, te je napravljen preostali dio utora. Na mjestu 

dodira tih dviju zna� ajki postavljene su relacije, odnosno izjedna� ene su vrijednosti 

dimenzija, kako bi UDF uvijek ispravno funkcionirao. 

 
Slika 62: Izgled donjeg dijela središnjeg uvrta oblika D u presjeku tijekom modeliranja za UDF 

 

Proces umetanja UDF-a od strane korisnika pogledati na stranici 42. 

 

4.5.4. Središnji uvrt oblika R 

Izgled središnjeg uvrta oblika R po normi : 

 
Slika 63: Izgled središnjeg uvrta oblika R 

Dimenzije koje su odre� ene normom: 

- dimenzija d1;  

- dimenzija d2;  

- dimenzija R.  
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 Središnji uvrt oblika R napravljen je pomo� u samo jedne zna� ajke - Hole. Za 

to rješenje Pro/E  tra�i samo dvije reference, a to su površina na kojoj se nalazi utor i 

os vratila. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 

 
Slika 64: Izgled središnjeg uvrta oblika R u Sketch-u tijekom modeliranja za UDF 

 

Proces umetanja UDF-a od strane korisnika pogledati na stranici 42. 

 

4.6. Utori za O-brtve 

 Utori za O-brtve izra� eni su prema preporuci iz literature pod rednim brojem 

[7.]. Svi utori se ne nalaze unutar jednog UDF-a, nego su podijeljeni na � etiri UDF-a 

ovisno o vrsti brtvljenja, te na� inu djelovanja tlaka u sustavu. Unutar prvog UDF-a 

nalaze se utori za O-brtve za aksijalno brtvljenje na vratilu ili osovini. Pod drugim 

UDF-om se nalaze utori za O-brtve za aksijalno brtvljenje na ku� ištu ili poklopcu. U 

tre� em i � etvrtom UDF-u nalaze se utori za O-brtve za radijalno brtvljenje na ku� ištu 

ili poklopcu. Oni su me� usobno razdvojeni u dva UDF-a ovisno o tome djeluje li tlak 

iznutra ili izvana, budu� i da se u tim slu� ajevima razlikuju referentne dimenzije u 

normi, kao što � e se vidjeti u nastavku. 

 U literaturi prema kojoj su izra� eni utori za O-brtve za aksijalno brtvljenje, oni 

ovise jedino o površini presjeka brtve, a ne o unutarnjem ili vanjskom promjeru brtve, 
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on se � ak u tablici s dimenzijama utora niti ne nalazi. U ustupljenoj literaturi nalazi se 

još tablica s utorima za O-brtve prema Švedskoj normi gdje te dimenzije postoje, no u 

dogovoru s mentorom odlu� eno je da se utori naprave prema prvoj tablici. Zbog toga 

su korištene kasnije navedene zna� ajke za izradu UDF-a za koje Pro/E tra�i � etiri 

reference, što je najve� i broj referenci za neki UDF u ovome radu. Jedan od razloga 

je taj i da korisnik ovisno o tipu brtve mora odabrati za referencu plašt vratila ili 

provrta kako bi se ostale dimenzije mogle prilagoditi. 

 S utorima za O-brtve za radijalno brtvljenje je potpuno suprotna situacija. Zbog 

njihovog polo�aja i drugih mogu � nosti kod modeliranja, napravljeni su pomo� u samo 

jedne zna� ajke i tra�e samo dvije reference. Problem unutarnjeg i li vanjskog 

promjera brtve i ovdje se pojavljuje, ali zbog � injenice da se ovdje ne treba upotrijebiti 

kao referenca riješen na prihvatljiviji i u� inkovitiji na� in za korisnika. Naime, korisnik 

prilikom umetanja pod varijabilnim dimenzijama upisuje unutarnji ili vanjski promjer 

utora, ovisno o tome koji se tra�i, odnosno koji je re ferentan s obzirom na djelovanje 

tlaka u sustavu. 

 

4.6.1. Za aksijalno brtvljenje na vratilu ili osovi ni 

Izgled utora prema preporuci: 

 
Slika 65: Izgled utora za O-brtve za aksijalno brtvljenje na vratilu ili osovini 

Dimenzije koje su odre� ene: 

- dimenzija d ozna� ava unutarnji promjer utora na vratilu ili osovini i nije 

definirana, definirano je samo da se izra� uje u tolerancijskom polju h9;   
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- dimenzija R1 je fiksna i iznosi 0,2 mm; 

- dimenzija R2 je fiksna i iznosi 0,5 mm; 

- dimenzija B ozna� ava širinu utora i tolerirana je kao što je prikazano na slici; 

- dimenzija T ozna� ava dubinu utora; 

- nagib od maksimalno 5°. 

 

 Utor za O-brtve za aksijalno brtvljenje na vratilu ili osovini napravljen je kao 

kombinacija tri zna� ajke - Revolve-a i dva Round-a. Za to rješenje Pro/E  tra�i � etiri 

reference. 

 UDF je izra� en tako da je na nekoj po� etnoj udaljenosti od � eone površine 

vratila nacrtan oblik utora koji je povezan s plaštom vratila pomo� u referenci u 

Sketch-u koji se nalazi unutar Revolve zna� ajke. Nakon toga, na model su dodatno 

postavljena zaobljenja prema preporuci. Sve tolerancije su postavljene na potrebnim 

kotama. 

 

 
Slika 66: Izgled utora za O-brtve za aksijalno brtvljenje na vratilu ili osovini tijekom modeliranja za UDF 

 U slu� aju da korisnik ne �eli imati utor sa nagibima i zaob ljenjima prema 

preporuci, nego �eli imati pravokutni utor treba jedno stavno editirati Sketch nakon 

umetanja i/ili izbrisati zaobljenja, no ovaj UDF izra� en je upravo radi izgleda utora po 

preporuci. 
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Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodelirano vratilo na koje se postavlja utor. Umetanje 

zapo� inje klikom na Insert > User Defined Feature... , nakon � ega treba odabrati 

mapa sa standardnim dijelovima, u ovom primjeru nazvan standardni_dijelovi.  

 

 
Slika 67: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore, isti odaberu, te se zatim klikne n a Open. Tada se otvara novi 

prozor u kojem je automatski odabrana druga opcija i tako treba ostaviti jer ona 

omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U slu� aju da se 

isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku zna� ajku 

posebno. Ako korisnik �eli, pored druge, mo�e odabrati jo š i tre� u opciju, što je 

preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog dijela. 

Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 
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Slika 68: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru presjeka 

brtve. Iz te liste odabere se promjer presjeka brtve koja se stavlja na vratilo, te klikne 

na Open. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 69: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati ravninu u 

kojoj se nalazi os vratila, a nakon toga u dijaloškom okviru odabrati 2. SURFACE, te 

sa strane pro� itati što se tra�i. U drugom koraku to je � eona površina vratila, te je 
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potrebno kliknuti na nju da bismo je odabrali. Nakon toga odabere se 3. AXIS, te se 

zatim klikne os vratila. Zatim odabiremo 4. SURFACE, te ozna� imo zadnju referencu, 

a to je vanjska zaobljena površina vratila, odnosno plašt. U istom tom prozoru (UDF 

Placement) potrebno je kliknuti na Variables, te pod opcijom Value unijeti tra�enu 

dimenziju, u ovom slu� aju udaljenost od � eone površine vratila do po� etka utora. Ova 

dimenzija nije odre� ena normom. Odabir se na kraju potvr� uje klikom na zelenu 

kva� icu. Nakon toga otvara se još jedan prozor, gdje je samo potrebno kliknuti na 

Okay za potvrdu orijentacije. 

 
Slika 70: Potvrda orijentacije 

 Onda se pojavljuje prozor u kojem je potrebno odabrati Next , a nakon toga u 

istom prozoru stisnuti Accept . Ovim postupkom odabiremo sljede� u referencu 

izme� u dvije ponu� ene, budu� i da referenca koju Pro/E automatski ponudi nije 

dobra. Ako se stisne samo Accept , bez prethodnog odabira Next , utor � e se 

napraviti izvan vratila u praznom prostoru i  ne� e biti vidljiv na modelu ili � e Pro/E 

javiti grešku kod umetanja. 

 
Slika 71: Izbor sljede� e reference 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 

 
Slika 72 Potvrda za kraj umetanja UDF-a 
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4.6.2. Za aksijalno brtvljenje na ku � ištu ili poklopcu 

Izgled utora prema preporuci: 

 
Slika 73: Izgled utora za O-brtve za aksijalno brtvljenje na ku� ištu ili poklopcu 

Dimenzije koje su odre� ene: 

- dimenzija d ozna� ava unutarnji promjer utora na ku� ištu ili poklopcu i nije 

definirana, definirano je samo da se izra� uje u tolerancijskom polju H9;   

- dimenzija R1 je fiksna i iznosi 0,2 mm; 

- dimenzija R2 je fiksna i iznosi 0,5 mm; 

- dimenzija B ozna� ava širinu utora i tolerirana je kao što je prikazano na slici; 

- dimenzija T ozna� ava dubinu utora; 

- nagib od maksimalno 5°; 

 

 Utor za O-brtve za aksijalno brtvljenje na ku� ištu ili poklopcu napravljen je kao 

kombinacija tri zna� ajke - Revolve i dva Round-a. Za to rješenje Pro/E  tra�i � etiri 

reference. 

 UDF je izra� en tako da je na nekoj po� etnoj udaljenosti od vanjske površine 

provrta gdje dolazi utor nacrtan oblik utora koji je povezan s plaštom provrta pomo� u 

referenci u Sketch-u koji se nalazi unutar Revolve zna� ajke. Nakon toga, na model 

su dodatno postavljena zaobljenja prema preporuci. Sve tolerancije su postavljene 

na potrebnim kotama. 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 56 

 
Slika 74: Izgled utora za utora za O-brtve za aksijalno brtvljenje na ku� ištu ili poklopcu u presijeku tijekom 

modeliranja za UDF 

 U slu� aju da korisnik ne �eli imati utor sa nagibima i zaob ljenjima prema 

preporuci, nego �eli imati pravokutni utor, treba jedn ostavno editirati Sketch nakon 

umetanja i/ili izbrisati zaobljenja i nagibe, no ovaj UDF izra� en je upravo zbog izgleda 

utora po preporuci. 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran provrt u ku� ištu u koji se postavlja utor. 

Umetanje zapo� inje klikom na Insert > User Defined Feature... , nakon � ega treba 

odabrati mapa sa standardnim dijelovima, u ovom primjeru nazvan 

standardni_dijelovi.  

 
Slika 75: Prvi korak kod ubacivanja UDF-a u model 
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 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore, isti odaberu, te se zatim klikne n a Open. Tada se otvara novi 

prozor u kojem je automatski odabrana druga opcija i tako treba ostaviti jer ona 

omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U slu� aju da se 

isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku zna� ajku 

posebno. Ako korisnik �eli, pored druge, mo�e odabrati jo š i tre� u opciju, što je 

preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog dijela. 

Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 

 
Slika 76: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru presjeka 

brtve. Iz te liste odabere se promjer presjeka brtve koja se stavlja na ku� ište, te klikne 

na Open. Zatim se otvara User Defined Feature Placement okvir. 
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Slika 77: UDF Placement prozor, opcije i izbor varijabli 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati ravninu u 

kojoj se nalazi os provrta, a nakon toga u dijaloškom okviru odabrati 2. SURFACE, te 

sa strane pro� itati što se tra�i. U drugom koraku to je površina na koj oj je izra� en 

provrt, te je potrebno kliknuti na nju da bismo je odabrali. Nakon toga odabere se 3. 

AXIS, te se zatim klikne os provrta. Zatim odabiremo 4. SURFACE, te ozna� imo 

zadnju referencu, a to je unutarnja zaobljena površina provrta, odnosno plašt. Odabir 

se na kraju potvr� uje klikom na zelenu kva� icu. U istom tom prozoru (UDF 

Placement) potrebno je kliknuti na Variables, te pod opcijom Value unijeti tra�enu 

dimenziju, u ovom slu� aju dubina na kojoj se nalazi po� etak utora. Ova dimenzija nije 

odre� ena normom. Nakon toga otvara se još jedan prozor, gdje je samo potrebno 

kliknuti na Okay. 

 
Slika 78: Potvrda orijentacije 
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 Onda se pojavljuje prozor u kojem je potrebno odabrati Next , a nakon toga u 

istom prozoru stisnuti Accept . Tako odabiremo sljede� u referencu izme� u dvije 

ponu� ene, budu� i da prva ponu� ena nije dobra .Ako se stisne samo Accept , bez 

prethodnog odabira Next , utor � e se napraviti izvan vratila u praznom prostoru i  

ne� e biti vidljiv na modelu ili � e Pro/E javiti grešku kod umetanja. 

 
Slika 79: Izbor sljede� e reference 

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 80: Potvrda za kraj umetanja UDF-a 

 

4.6.3. Za radijalno brtvljenje s tlakom izvana 

Izgled utora prema preporuci: 

 
Slika 81: Izgled utora za O-brtve za radijalno brtvljenje s tlakom izvana 



� � � � � � � � � 	 
 � � 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  

� � 
 � �� � � � � � � �  ! !"#$ ! !%#� 60 

Dimenzije koje su odre� ene: 

- dimenzija d ozna� ava unutarnji promjer utora i izra� uje se u tolerancijskom 

polju h11;   

- dimenzija R1 je fiksna i iznosi 0,2 mm; 

- dimenzija R2 je fiksna i iznosi 0,5 mm; 

- dimenzija B ozna� ava širinu utora i tolerirana je kao što je prikazano na slici; 

- dimenzija T ozna� ava dubinu utora i tolerirana je ovisno o promjeru presjeka 

brtve; 

- nagib od maksimalno 5°. 

 

 Utor za O-brtve za radijalno brtvljenje s tlakom izvana napravljen je pomo� u 

samo jedne zna� ajke - Hole. Za to rješenje Pro/E  tra�i samo dvije reference, a  to su 

površina na kojoj se nalazi utor i os oko koje je izra� en. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 

 

 

 

 

Slika 82: Izgled utora za O-brtve za radijalno brtvljenje na ku� ištu ili poklopcu u Sketch-u tijekom modeliranja za 

UDF 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran dio vratila na koji se postavlja uvrt, a potrebno 

je uklu� iti i prikaz osi. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapa sa standardnim dijelovima, u ovom 

primjeru nazvan standardni_dijelovi.  
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Slika 83: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore, isti odaberu, te se zatim klikne n a Open. Tada se otvara novi 

prozor u kojem je automatski odabrana druga opcija i tako treba ostaviti jer ona 

omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U slu� aju da se 

isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku zna� ajku 

posebno. Ako korisnik �eli, pored druge, mo�e odabrati jo š i tre� u opciju, što je 

preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog dijela. 

Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 

 
Slika 84: Insert UDF prozor i opcije 
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 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru presjeka 

brtve. Treba napomenuti da zbog nemogu� nosti korištenja to� ki ili zareza u nazivu 

instanci korišten je znak "-". Primjerice, broj 3-53 u instanci ozna� ava promjer 

presjeka brtve iznosa 3,53 mm. Iz te liste odabere se tra�ena brtva, te se klikne na 

Open. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 85: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati površinu na 

kojoj se nalazi utor, a nakon odabira u dijaloškom okviru odabrati 2. AXIS, te sa 

strane pro� itati što se tra�i. U drugom koraku to je os oko koje se  nalazi utor. U istom 

tom prozoru (UDF Placement) potrebno je kliknuti na Variables, te pod opcijom Value 

unijeti tra�enu dimenziju, u ovom slu � aju unutarnji promjer utora. Ova dimenzija nije 

odre� ena normom. Odabir se na kraju potvr� uje klikom na zelenu kva� icu.  

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 
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Slika 86: Potvrda za kraj umetanja UDF-a 

 

4.6.4. Za radijalno brtvljenje s tlakom iznutra 

Izgled utora prema preporuci: 

 
Slika 87: Izgled utora za O-brtve za radijalno brtvljenje s tlakom iznutra 

Dimenzije koje su odre� ene: 

- dimenzija d ozna� ava vanjski promjer utora i izra� uje se u tolerancijskom polju 

H11;   

- dimenzija R1 je fiksna i iznosi 0,2 mm; 

- dimenzija R2 je fiksna i iznosi 0,5 mm; 

- dimenzija B ozna� ava širinu utora i tolerirana je kao što je prikazano na slici; 

- dimenzija T ozna� ava dubinu utora i tolerirana je ovisno o promjeru presjeka 

brtve; 

- nagib od maksimalno 5°. 
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 Utor za O-brtve za radijalno brtvljenje s tlakom iznutra napravljen je pomo� u 

samo jedne zna� ajke - Hole. Za to rješenje Pro/E  tra�i samo dvije reference, a  to su 

površina na kojoj se nalazi utor i os oko koje je izra� en. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 

 

 

 
 

Slika 88: Izgled utora za O-brtve za radijalno brtvljenje na ku� ištu ili poklopcu s tlakom iznutra u Sketch-u tijekom 

modeliranja za UDF 

 

Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran dio vratila na koji se postavlja uvrt, a potrebno 

je uklju� iti i prikaz osi. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapa sa standardnim dijelovima, u ovom 

primjeru nazvan standardni_dijelovi.  
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Slika 89: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore, isti odaberu, te se zatim klikne n a Open. Tada se otvara novi 

prozor u kojem je automatski odabrana druga opcija i tako treba ostaviti jer ona 

omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U slu� aju da se 

isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku zna� ajku 

posebno. Ako korisnik �eli, pored druge, mo�e odabrati jo š i tre� u opciju, što je 

preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog dijela. 

Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 

 
Slika 90: Insert UDF prozor i opcije 
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 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru presjeka 

brtve. Treba napomenuti da zbog nemogu� nosti korištenja to� ki ili zareza u nazivu 

instanci korišten je znak "-". Primjerice, broj 3-53 u instanci ozna� ava promjer 

presjeka brtve iznosa 3,53 mm.  Iz te liste odabere se �el jena brtva, te se klikne na 

Open. Zatim se otvara User Defined Feature Placement okvir. 

 
Slika 91: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati površinu na 

kojoj se nalazi utor, a nakon odabira u dijaloškom okviru odabrati 2. AXIS, te sa 

strane pro� itati što se tra�i. U drugom koraku to je os oko koje se  nalazi utor. U istom 

tom prozoru (UDF Placement) potrebno je kliknuti na Variables, te pod opcijom Value 

unijeti tra�enu dimenziju, u ovom slu � aju vanjski promjer utora. Ova dimenzija nije 

odre� ena normom. Odabir se na kraju potvr� uje klikom na zelenu kva� icu.  

 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 
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Slika 92: Potvrda za kraj umetanja UDF-a 

 

4.7. Utori za Siemering brtve 

Utore za Siemering brtve opisuje norma DIN 3760. Izgled utora prema normi : 

 
Slika 93: Izgled utora za Siemering brtve 
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Dimenzije koje su odre� ene normom: 

- dimenzija t1 ozna� ava udaljenost od kraja skošenja do kraja utora;  

- dimenzija t2 ozna� ava ukupnu dubinu utora;  

- dimenzija D2 ozna� ava vanjski promjer utora i izra� uje se u tolerancijskom 

polju H8;  

- kut od 5° do 10°.  

  

 Dimenzija kuta od 5° do 10° ograni � ena je u relacijama, tako da korisnik ne 

mo�e izabrati kut manji od 5° i kut ve � i od 10°. 

 Dimenzija t1 i t2 u normi su dane kao izraz t1 ³ 0,85b, odnosno t2 ³ b+0,3. Ova 

� injenica da dimenzije utora ovise isklju� ivo o dimenzijama brtve predstavljala je 

veliki problem, budu� i da se postavlja pitanje kako povezati navedene dimenzije s 

dijelom, odnosno brtvom, koju nemamo izmodeliranu i koja nije dio samog modela. 

Zato je u dogovoru s mentorom odlu� eno da se dimenzije pove�u s brtvama 

proizvo� a� a SKF. Dimenzije t1 i t2 su izra� unate na svoju minimalnu vrijednost, te 

kao takve unesene su u Family Table. U slu� aju da korisnik �eli imati ve � u dimenziju 

od unesenih ili neku zaokru�enu vrijednost dimenzije, nak on umetanja UDF-a mora 

ru� no unijeti svoje dimenzije desnim klikom na zna� ajku > Edit definition > 

Sketcher , te u Sketch-u upisati svoje dimenzije. 

 Utor za Siemering brtve napravljen je pomo� u samo jedne zna� ajke - Hole. Za 

to rješenje Pro/E  tra�i samo dvije reference, a to su površina na kojoj se nalazi utor i 

os provrta oko kojeg se nalazi utor. 

 UDF je izra� en tako da je u zna� ajki Hole odabrana opcija Sketched, te je u 

Sketch-u nacrtan oblik utora. 

 
Slika 94: Izgled utora za Siemering brtve u Sketch-u  tijekom modeliranja za UDF 
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Proces umetanja UDF-a od strane korisnika:  

 Korisnik mora imati izmodeliran dio na koji se postavlja utor, te provrt. Po�eljno 

je uklju� iti i prikaz osi. Umetanje zapo� inje klikom na Insert > User Defined 

Feature... , nakon � ega treba odabrati mapa sa standardnim dijelovima, u ovom 

primjeru nazvan standardni_dijelovi.  

 

 
Slika 95: Prvi korak kod ubacivanja UDF-a u model 

 Mapa sa standardnim dijelovima se automatski otvara ako je ona ujedno i 

radna, što je rijetkost, ili ako je navedena pod opcijom pro_group_dir u 

konfiguracijskoj datoteci. Drugi korak je da se u mapi sa standardnim dijelovima 

klikom na �eljene utore, isti odaberu, te se zatim klikne n a Open. Tada se otvara novi 

prozor u kojem je automatski odabrana druga opcija i tako treba ostaviti jer ona 

omogu� uje odabir prije definiranih referenci za grupu zna� ajki. U slu� aju da se 

isklju� i, korisnik � e morati ponovno definirati reference, i to za svaku zna� ajku 

posebno. Ako korisnik �eli, pored druge, mo�e odabrati jo š i tre� u opciju, što je 

preporu� ljivo za po� etak dok se ne stekne "osje� aj" za umetanje odre� enog dijela. 

Ta tre� a opcija (View source model ) omogu� uje da se prika�e izvorni model s 

ozna� enim referencama koje treba odabrati na dijelu koji modeliramo. 
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Slika 96: Insert UDF prozor i opcije 

 Nakon klika na OK, otvara se prozor Select instance sa listom svih UDF-ova iz 

odabranog standarda, u ovom slu� aju lista utora sortiranih po promjeru vratila, 

obilje�enom vanjskom dimenzijom provrta i širinom brtve. Iz te liste odabere se 

�eljena brtva, te se klikne na Open. Zatim se otvara User Defined Feature Placement 

okvir. 

 
Slika 97: UDF Placement prozor, opcije i izbor referenci 

 Potrebno je slijediti upute u tom okviru. Prvo je potrebno odabrati površinu na 

kojoj se nalazi utor, a nakon odabira u dijaloškom okviru odabrati 2. AXIS, te sa 

strane pro� itati što se tra�i. U drugom koraku to je os provrta. Oda bir se na kraju 

potvr� uje klikom na zelenu kva� icu.  
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 Zatim otvara se još jedan prozor gdje je tako� er potrebno samo potvrditi, u 

ovom slu� aju klikom na Done. Ovime je završen proces umetanja ovog UDF-a. 

 
Slika 98: Potvrda za kraj umetanja UDF-a 
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5. ZAKLJU � AK 

 Tijekom dosadašnjeg studija i izrade rada uvidio sam da ovaj i sli� ni radovi 

mogu biti vrlo univerzalni i iznimno korisni i imati velike mogu� nosti prakti� ne 

primjene gdje god se koristi program Pro/E. Osim toga, ovakve baze podataka štede 

konstruktoru vrijeme prilikom konstruiranja, a još ve� a prednost je da korisnik ne 

treba imati norme i ne treba tra�iti po normama izgl ed, dimenzije, tolerancije itd., 

budu� i da se sve nalazi unutar biblioteke standardnih dijelova i oblika. 

 Neke stvari u ovom radu su se mogle napraviti i na druga� iji na� in, no � esto 

sam se dvoumio i savjetovao se s par kolega i mentorima kako bih što objektivnije 

odlu� io s njihove (i moje) strane korisnika, koje je rješenje bolje. Tako se na prvi 

pogled mo�e � initi da je rješenje komplicirano, no, krajnje mišljenje je ipak da je 

dobro za snala�enje korisnika i zbog preglednosti. Tu k ao primjer mogu navesti utore 

za klinove i pera. Prva opcija je bila staviti sve utore za klinove i pera u jedan UDF i 

kada korisnik postavlja UDF na model, otvara mu se velika tablica sa svim utorima za 

sve vrste klinova i pera (visoka pera i klinovi, niska pera, te plosnati klinovi). Drugo 

rješenje, koje je uzeto kao i krajnje rješenje u ovom radu, bilo je ve�  na po� etku 

razvrstati i odvojiti u tri skupine - visoka pera i klinovi, niska pera, plosnati klinovi. U 

ovom slu� aju kada korisnik postavlja UDF na model otvara mu se samo tablica koju 

je zatra�io, primjerice utori za visoka pera.  

 Osim mogu� nosti proširivanja rada sa brojnim ostalim skupinama standardnih 

dijelova, postoji veliki potencijal i za podizanje na neki "viši nivo", kao što je primjerice 

automatsko umetanje usko� nika u sklopu na mjesto utora, što bi se moglo izvesti 

programiranjem u Pro/PROGRAM-u koji se nalazi unutar Pro/E-a. 
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